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Introduction

Pull-down menu:

The page describes the layout for pages to follow: | * Signifies a command in the Symbol
Editor only.

** signifies a command which is not
available at MyAnalog Station.

File=>New...

Command Description
It creates a cell.

\ Description of
a command

Create Yiew Dialog E |
Library Name: TS - |

=53 clock -
- beddry
- CLOCK
- FRODIV
- MD-10 Dialog box

- MDEDRY [ explanation

ol i RANME 1N

Usage & Dialog Box

Cell Marne: I | ok, I

Yiew M arne: Ischematic j Cancel |
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SchEd: Schematic Editor

File 2 New...

Command Description

It creates a cell. It is activating when an MDC file was opened.

Note: MDC (MyCAD Design Context) file contains the information about

library names.

Usage & Dialog Box

Create Yiew Dialog

Library Name: [ S————

Choose a library name

which is containéd at
MDC file,

B3 clock
- boddry
- CLOCK
- FRODMY
- MD-10
- MDEDRY
. M LANNE_ 1N

List View

Show the cell lists that
are contained at the
L| selected library.

&
<

Cell Mame: I

Wiew Mame; Ischematic

{ Cancel |

/

Specify the cell name by typing
or clicking a cell from List View

Choose the type of view:
schematic,symbol, truthtable,
statetable, rom, ram, statediagram
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Library Name: If you made several working libraries that were maintained by the
mdc file, you can choose one of library lists on this selection box.

List View: It shows the cell lists contained to the mdc file.

Note: The schematic view and the symbol view are only available at the
analog design.

10
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File = Open...

Command Description
It opens a cell and its view.

Usage & Dialog Box

Open Yiew Dialog
Libramy Mame;

Choose a library name
which is contained at
MDC file.

53 clock
- beddry
- CLOCK
- FRODIY
- MD-10
- MDEDRY

o il RANME. AN

List View

j Show the cell lists that
are contained at the
selected library.

Cell Marne:

oK |

Ischematic

Wiew Mame;

Cancel |

L4l

Specify the cell name by typing
or clicking a cell from List View

11

Choose the type of view:
schematic,symbol, truthtable,
statetable, rom, ram, statediagram
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File =2 Save

Command Description
It saves the current working view.

File 2 Close

Command Description
It closes the current working view.

Note: SchEd checks whether the view is changed or not, before closing it. If
not, you can see the following dialog box.

Schematic Editor

& Save changelo clucka’bcddrvfschematlc7

Mo | Cancel |

It shows the path of working view.

12
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File > New Design Context...

Command Description
It creates an mdc file.

Note: If an mdc file is working, then the following dialog box is appeared.
Click on “OK” button with the left mouse button.

Schematic Editor E3

& Create Mew Design Contest?
Cahcel |

Usage & Dialog Box

Save in: Iﬁ My Documents j gl

1 by Fictures

Filz namme: || Save I
Save as bype: IDesign Cortest Files [ mdi) j Cancel |

File name: Move to the directory and type new mdc filename. The extension mdc
does not need to be typed because it is automatically attached.

13
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If you click on the “OK” button with the left mouse button on New Design
Context dialog box, then the following dialog box will be shown.

Schematic Editor Ed

& Create Mew Library ?
Cancel |

Click on “OK” button with the left mouse button, then SchEd creates new library
named after mdc file’s name.

14
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File > Open Design Context...

Command Description
It opens an mdc file.

Note: It is working an mdc file. Then, SchEd automatically closes it before
opens another mdc file.

Usage & Dialog Box

Open  @EH|
Lank jr I ‘2 Clack j El
1 Bcddry (1 Mode-12 [ Outlpad (] Simnzed
" Clack (1 tode-s | OutZpad 2 Stopwatchk
| Frodiv 1 Modeszel 1 Outzel [dwiatch Click an mdc file
"1 Md-10 C Mot (1 5elt “clock, mdc with the left mouse
1 MdlGicry (I Mout2 (15el2 button
1 Mode-10 [C10_pad 1 Simck
1| | ol
File name: Il:ll:u:k.mdl: Open I
Files of type: IDesign Contest Files [*.rdc) j Cancel |

15
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File - Save Design Context

Command Description
It saves the current working mdc file.

Note: When an mdc file is closed, then it is automatically saved.

File > Save As Design Context...

Command Description

It saves as the current working mdc file into another. Specify the destination that
is saved mdc file.

Usage & Dialog Box

=]
. x = _— :

Save | 3 Clock =l i
|1 Bcddr: (1Mode-12 (1 0utlpad (1 Simmsed
1 Clack, ClMades | QutZpad (i Stopwatck
| Frodie [ Modesel 1 Outsel Cwatch
[ 1Md10 C Mot Ca5en BB clock. mdc
1 MdGdry L Mout? Ca5el
1 Made-10 C10_pad 0 Simelk

1] | 2
File name: | N Save I
Save as type: IDesign Contest Files [*.mdc] j ﬂl

Type the mdc file's name with the
absolute path.
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File = Close

Command Description
It closes the current working mdc file.

File > Create Library...

Command Description
It creates a new library.

Specify the destination that
is saved library file.

Usage & Dialog Box

Save in; I'ﬁ Clock A j | |=j<| |
[ Bcdded (O Mode-12 (1 0ut1pad [ Simmsel
1 Clack ClMades s | QutZpad s | Stopwatch
1 Frodiv 1 Madesel C Outsel Clwatch
[ IMd-10 LI Mot (I selt clack.iib
1 MdBdre ClNout2 Clsel
"I Mode-10 C10_pad ClSimelk

1] |

il

File name: | Save I
Pad

Save a%l Library File [*lib] j Cancel |

Type the library file’s name with the 17

absolute path.
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File > Add/Remove Library...

Command Description
It adds the library into the current working mdc file and also removes the library
from the current working mdc file.

Note: MyLogic Station provides two kinds of library parts. One part can be
used for both Xilix FPGA design and Altera FPGA design, the other can be
only used for drawing a schematic. And then, user library sets are also
available to add/remove library.

There are Spartan XL, Spartan, and XC4000E series for Xilinx's FPGA
design.

And, Analog library subsets are only available at MyAnalog Station.

Add button List View: show
the bound library

Usage & Dialog Box
Add Library =z lists i_nto curre_nt
working mdc file.

— Reserved Library
-.t’-‘n.ltera_p -
Analog
SCMOS

Spartan
Spartari=L

R i Tnlnn '\ﬂ

~ User Library Show the reserved library lists.
Add I Remove |

DA ypCaDhdemotsdshClockhclock. lib

Remove button

L\

ok | CANCEL | \

18 | Show the current working library lists.
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To add a library into current working mdc file, choose one of library at Reserved
Library view on Add Library dialog box. And click on “Add” button with the left
mouse button at Reserved Library view.

Note: The reserved library names are added during the installation into
windows registry.
If you want to add the library which is not included at the reserved library list,
click on “Add” button at User Library view. Then, the following dialog will be
shown.

B User by ES]
Laak i |E Clock j ﬁl

1 Beddr: (1 Mode12 (1 0utlpad (1 Simmsel
1 Clack 1 Modes | QutZpad [ Stopwatck
1 Frogdiv 1 Modesel 1 Outsel C1wateh
1 Md-10 C Noutt O gl clack. lib
1 M dEdry Ca Moz Cas5el?
1 Mode-10 C10_pad 1 Simclk.

1] | o

File name: | Open I
Files of twpe: | Library Files [*.lib] =] Cancel |

Locate the directory of the library and resister it at Add User Library dialog box.

To remove the library from the current working mdc file, select the library at List
View with the left mouse button and click on “Remove” button at Reserved
Library view.
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Note: You cannot remove the current using library, then you can see the
following dialog box.

Schematic Editor |

& Wwarning : One of views in libran ‘clock’ iz opened. Y'ou must cloze all opened views!l

File > Convert Project...

Command Description
It converts the MyLogic V2.1 data format into V5.1 data format because there is
lot of difference between them.

Usage & Dialog Box Choose the converted library file.

Convert Old Format to Hew Format |

Library : Im /ﬂ QE. I
— Convert vigws

< zchems i Cancel |

¥ zymbal —
——— | | Setupthe
~ Option | changes
¥ ovenvrite
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File = Print...

Command Description
It prints out the current working view.

Usage & Dialog Box

Pt EH|
— Printer
Hame: Propertiez |

Status; Drefault printer; Beady
Type: HF Lazerlet 4
Wwhere:  Mlsparkhhpd

Comment: ™ Print to file
— Print range Copiez
i Muriber of copies: 1 -

" Pages  from: |1 e
5 Selection Iﬁl ™| Callate

] I Cancel |
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File = Print Preview

Command Description
It will preview the printing.

Usage & Dialog Box

et F'agel Erey, F'agel Tiwe Page | Zoom [h | Zoomthl Claze

Page 1 [x=-327 [p=743 4

Related Commands

Whether to print frame or multiple pages can be configuration at Tools =
Options... PPrint (tab) from pull-down menu of SchEd.
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File = Print Setup...

Command Description

It will setup the printer and paper.

Usage & Dialog Box

Print Setup HE |
— Printer
Hame: Propertiez |
Status; Drefault printer; Beady
Type: HP Lazerlet 4
Wwhere:  Mlsparkhhpd
Comment;
— Paper Orientation
Size: ILetter 31/2=11in j i+ Puoilrait
Source: I.-’-‘-.ut::u Select j " Landscape

] I Cancel
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File = Document Info...

Command Description

It will bring up the Document Information dialog box.

Usage & Dialog Box

Document Information E |

Maotes ;

— Prafile
Title
kA0-10
—Date & Time
Date Time
Wt Define

ak I Cancel

Title: It shows the name of current working view.

Auto Define: It setup whether date and time are printed automatically or not.

Notes: You can describe the relevant information.
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File > Exit

Command Description

It closes the SchEd.

Edit 2 Undo

Command Description

It undoes the editing. It is only activate when the object on the Schematic view or

the Symbol view was edited.

Edit 2 Redo

Command Description

It redoes the editing which was undone.

25



MyLogic Station V5.1 Schematic Editor Manual

Edit =2 Cut

Command Description
It wipes out the selected object and put it into the clipboard.

Note: No other application except SchEd can paste the object in the clipboard.

Edit = Copy

Command Description
It copies the selected object to the clipboard.

Note: No other application except SchEd can paste the object in the clipboard.

Edit 2 Paste

Command Description
It pastes the object which has been copied or cut to the clipboard.

Note: The object to be pasted will appear in the middle of the active window.

Edit = Delete
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Command Description
It deletes the selected object.

Edit = Select All

Command Description
It selects all the objects.

Edit = Array Copy...

Command Description

It will copy the selected object array based on the specified number on No. of
objects field.

Usage & Dialog Box

Start by selecting objects from current working view, and selecting Edit =2 Array
Copy... from pull-down menu of SchEd. Then, the following dialog box will be
shown. Type the number at No. of object field.
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Mo, of objects

Cancel

L/j

Type number

Two dimension: It checks on when you want to copy two-dimensional array.
And you check on this box. Then, the following dialog box will be shown.

T N |

Ma. af abjects harizantally :

Mo, of objects vertically ;

.
i

Cancel |

™

Type number

No. of objects horizontally: You can specify the number of horizontal array.

No. of objects vertically: You can specify the number of vertical array.
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Edit = Find...

Command Description
This command enables for you to find a symbol, text, and port name at SchEd. It
will locate the symbol, text, and port name on the working window.

Usage & Dialog Box

I |

Find what;
|
™ Match whols word Firnd &Il |
[~ Match case
Cancel |

Edit = Find Next

Command Description
It will find a symbol, text, and port name at the different place after finding it by
Edit 2 Find command.
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View = Redraw

Command Description
It will redraw the screen and refresh the image of the current working window.

View =2 Whole Page

Command Description
It will display the whole fit in the current working window.

View =2 Zoomlin

Command Description
It will zoom in by 2.
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View = ZoomOut

Command Description
It will zoom out by 2.

View - Design Manager

Command Description

It toggles the display of Design Manger on SchEd.

View - Status

Command Description
It toggles the display of Status bar on SchEd.
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View - Properties...

Command Description

It will show the properties of selected object.

Usage & Dialog Box

Library Property
Select a library on Design Manager of SchEd with the left mouse button, and

choose View 2 Properties... from pull-down menu of SchEd. Then, the following
dialog box will be shown.

Library Property [ x|
Marne:

Icluck

Fath
ID:\MyD’-\D\demo\sds\CIock\clock. lib

Cells

beddry
CLOCK,

FRADIY
MD-10
MDEDRY
MODE-10
MODE-12
MODE-5
MODESEL
MOUT1
NOUT2
OUT1PAD
OUT2P4D
OUTSEL
0_PaD
SEL1
SEL2
SIMELK.
SIMMSEL
STOPWATCH
WATCH
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You can see the cell lists that are contained at the selected library and its path.

Cell Property
Select a cell on Design Manager of SchEd with the left mouse button, and choose

View 2 Properties... from pull-down menu of SchEd. Then, the following will be
shown.

Cell Property E

M ame

II:LEICK

Path
ID:'\MyE.-’-\D'\demn\sds'\tlock‘\clnck'\

Wigtwg

rietlist
hierarchy
zchematic

It just displays the view lists contained to the cell.

View Property
Select a view on Design Manager of SchEd with the left mouse button, and choose

View 2 Properties... from pull-down menu of SchEd. Then, the following will be
shown.
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Yiew Property

Type

Ischematic

Path

ID:'\M_I,JE.&D'\DEMD'\mydir\sym_inv\\schematic

Created Time

I 22:19:24 04-03-2001
Last Modified Time

I 22:20:26 04-03-2001

BUS Property
Select a BUS on the Schematic View, and choose View = Properties... from pull-
down menu of SchEd. Then, the following dialog box will be shown.

Bus

Buz Froperty |

It shows the BUS
name: You can
modify the BUS
name

Harme : ISSEE[E:D]

ﬁn:nt
Bug segment iz similar to the net segment,

but it's not mere the only one wire but a
cohtairer of multiols nets.

It alen haz a name like any other objects,
and pou can choose how the name to be
dizplayed with the mode field specify.

Mode [vaLUE ONLY ]

. Calor... |

Click the above button to
change the current color

zetting

Reset |

It displays the created time and the last modified time of the view.

Ok, I Cancel |

gl |

Help

34



MyLogic Station V5.1 Schematic Editor Manual

Mode: It controls the display mode.
OFF: It does not display both name and value of BUS on the Schematic View.
NAME ONLY: It only displays the name of BUS on the Schematic View.

BOTH: It displays both name and value of BUS on the Schematic View.

Display Property
If you double click the property of object on whether the Schematic View or
Symbol View, then, the Property dialog box will be shown.

Property |
Show the name of

Display Propert |
i Bl selected property.

Property Hame : IMEIDEL <+

Property Yalue : INMDS

Display Mode : Edit :
BOTH | |weLUE_ENzBLE x|
Fant
Height : Alignment ;

15 [TOP-LEFT = |
Angle : ID "I Beset |

ak I Cancel | Lppli | Help |

Property Name: It shows the name of selected property. And, it is only activate
when the object of symbol is selected at the Symbol View.
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Property Value: It shows the value of selected property. And it is modifiable.

Display Mode: It controls the display mode of selected property.
OFF: It does not display both name and value of property.
NAME ONLY: It only displays the name of property.
BOTH: It displays both name and value of property.

Edit: It controls the editable of value of property.
DISABLE: It makes all unselectable.
VALUE_ENABLE: It makes the value of property editable.
ALL_ENABLE: It makes all editable.

Height: It setup the height of text of property.

Alignment: It sets up the alignment of property.

Angle: It rotates the property by degree.

Color: It changes the display color of property into another.

Note: In general, the Edit mode is not activating except when you edit the
symbol instance. However, the symbol instance becomes no modifiable at
the Schematic View.
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Instance Property
Select the instance at the Schematic View, and choose View = Properties... from
pull-down of SchEd. Then, the Instance dialog box will be shown.

Instance |

Instance Property | Properties I

Instance Name : |IE Mods : IW«LLIE OMLY vI

— Describer
Library : IXE3DDEI Browszer ... |
Cel: |ﬁND282

Simulation kMadel:

schematic

— Comrment

. o : Calar...
Instance iz a schematic object representing symbol, . ‘_l

‘You can choose any symbal from the library or make
wour awn symbol with symbol editar.

Rezet |

Ok I Cancel Ay Help |

Instance Property tab:
Instance Name: It shows the instance name.
Library: It shows the information of library of instance. You can change the

instance into another library by clicking “Browser” button. Then, the following
dialog box will be shown.
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Which view do you want bind this instance to ?

Library Mame:

-G ADSLG A
—

-8 ADSU4

g s You can change the

@; ANDZE1 | cell into another.
A3 [aMD2B2

- W LI

I
Wiew Mame: Ischematic =l Carize] |

Cell: You can change the current instance into another at the current library by
clicking “Browser” button. Then, the above dialog box will be shown.

Simulation Model: It displays the simulation model of selected instance. You can
change the simulation model into another.

Properties tab:

This tab is useful at a circuit design. In general, you have better avoid using this
tab on the logic design.

The following diagram is showing the properties of NMOS instance.

The format of property is : “NAME=VALUE”
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Instance |

Instance Property  Properties |

= ) § Mode  [roTH -]
MODEL = PMOS

PREFIX = M Height |-|5

L=10U

W =200 Alighrnent ITDF‘-LEFT vI

Add | Ehangel Qeletel

List View

[ Zpply to all abjects

Ok I Cancel Ay Help

* Change Property

Start it by selecting one from List View. And click “Change” button on the
Instance dialog box with the left mouse button. Then, the following dialog box
will be shown.

Edit Property ltem |

MName IMDDEL

Yalue IF'MDSI

Mode [BOTH =

Fant

Height Alignmment

|15 [ToP-LEFT =]

Cancel |
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If the selected name is given by default, then you could not change it. In that case,
you only change the value.

* Add Property

Click “Add” button on the Instance dialog box with the left mouse button. Then,
the following dialog box will be shown.

Edit Property Item |
Narme ||
Value |
Mode [BOTH =l
i?a?;ht Aligrment
[15 | TOP-LEFT =] — |

Specify the name at the “Name” text input box. And Specify the value at the
“Value” text input box.

* Delete Property

Select the property that you want to delete on the List View with the left mouse
button. And, click “Delete” button on the Instance dialog box. Then, selected
property will be deleted.
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Net Property
Select a net on the Schematic View with the left mouse button. And, choose
View =2 Properties... from pull-down menu of SchEd. Then, the Net Property
dialog box will be shown.

Met Property Ed |

Met Property |

Name : | Mode : IW-‘«LLIE OMLY vI
— Comment
Color. .
Met zegment iz the schematic object . _l

connecting instances, portz, buses with Click the abowe button to
each other. _ : change the current calar
It alzo has a name like any other objects, zetting

and you can choose haw the name to be
dizplayed with the mode field specify.

Beszet |

Q. I Cancel | Al | Help |

Name: You can specify the local name of net. If you do not assign the local name
of net, SchEd will automatically assign local name into each net.
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Port Property
Select the port on the Schematic View with the left mouse button. And, choose

View = Properties... from pull-down menu of SchEd. Then, the Port dialog box
will be shown.

Pt M

Puort Froperty | Properties I

Mame - |ELK Mode - I‘MLLIE aMLY vI

— Cammrnent

- . Calar... |
Fart name iz dizplayed near the port,
“fou can specify how the port name to be displayed. Click the above
If you chaoze Mode as NOME, the port name will nat button to change
be displayed. the current color

zetting
Reszet |

Q. I Cancel i Help |

Name: You can specify the port name. If you do not assign the port name, SchEd
will automatically assign port name.
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Add - Port = Input

Command Description
It adds the input port.

Usage & Dialog Box

The input port will locate the middle of the Schematic View. Move it into
properly location by dragging.

Add - Port ->Output

Command Description
It adds the output port.

Usage & Dialog Box

The output port will locate the middle of the Schematic View. Move it into
properly location by dragging.
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Add = Port 2 InOut

Command Description
It adds the bi-directional port.

Usage & Dialog box

The bi-directional port will locate the middle of the Schematic View. Move it into
properly location by dragging.

Add - Figure - Line *

Command Description
It adds the line object.

Usage & Dialog Box

The line object will locate the middle of Symbol View. Handles are shown at both
end of the line. The line is positioned and moving the handle changes the length.
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Add - Figure - Rectangle*

Command Description
It adds the rectangle object.

Usage & Dialog Box

The rectangle object will locate in the middle of Symbol View. The four handles
are displayed. By poisoning each handle to the desired position, the rectangle is
formed with positioned corners.

Add - Figure - Circle *

Command Description
It adds the circle object

Usage & Dialog Box

The circle object will locate in the middle of Symbol View. The four handles are
displayed. The size of circle is determined by moving four handles.
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Add - Figure = Arc *

Command Description
It adds the arc object.

Usage & Dialog Box

The three handles are displayed. Positioning the two end points to the desired
points, and moving the middle handle to the desired are shape. The position and
form of the arc is determined by the positions of three handles.
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Add - Figure - Text *

Command Description
It adds the text object.

Usage & Dialog Box

Text | x|

Text Property |

Content :

— Font
Height : Aligrment ; Angle

|15 {TOP-LEFT = oo =]

. LColer... |
Beset |

k. I Cancel iy | Help |

Type the text at the Content input box. Click “OK” button with left mouse button.
Then, the text object will locate in the middle of Symbol View. Move it into
properly location.
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Add = Net Mode

Command Description
It toggles the net mode.

Usage & Dialog Box

In the net mode, drawing wire is only possible. To get out of net mode, double
click the left mouse button or choose Add = Net Mode from pull-down menu of
SchEd.
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Wiring (it does not include in the pull-down menu of SchEd)

Wiring is used only in the Schematic View.

The basic of drawing a wire
Click with the mouse left button on working area of the Schematic View. The red-
dot is shown as in the following diagram. (Only if you use the default color of
SchEd.)
Drag the muse cursor to the end point, and then drop. You can draw wire to any
direction from the red-dot point.

=4 circuit/inv/schematic E=]

Click on the working area of the

k < = Schematic View with the left
mouse button:

the bounding box is appeared

Draw wire to the desired position

by dragging the mouse:

€ i
T %3 The mouse cursor shape is

changed during dragging.
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Another way of wiring (from the symbol object’s end point)
Click the left mouse button on the net point of a symbol object, then drag the
mouse to the desired end point of the net and drop.

=4 circuit/iny/schematic =]

Place the mouse cursor on the net
PMOS < - point:
The bounding box of the net point is
appeared
4] I AW

j‘ Click on the net point of symbol,

symbol’s color is changed to green

PMOS - Drag to the desired position:
the mouse cursor shape is changed
< - during wiring job.
<] [ AW
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Another way of wiring (from the port point)

Click the left mouse button on the port point. Then drag the cursor to the desired
end point of the net and drop.

=4 circuit/inv/schemn, ., =] E3

Place the mouse cursor on the port

% < _— point:

The bounding box is appeared.

Click on the port point:

/ The port’s color is changed.
Drag to the desired position:

The mouse cursor shape is

1

changed during wiring job.

1
—
B
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Junction

If two wires are connected, then the junction mark is appeared. You distinguish it
whether they are connected or not.

=4 circuit/iny/schem. .. [l B3
H nction Mark
e Junctio al
ol
N
L When two wires are connected,
=
ﬂ{ the junction mark is appeared.
(Lok=3
| -
] I AW
Wire Mode

There are three kinds of wire mode, horizontal first, vertical first, and diagonal.
Click Shift key or Ctrl key on the keyboard, then three wire mode displays.

A T A [ A ‘\‘
B B B
Horizontal first Vertical first Diagonal
(Shift key) (Shift key) (Ctrl key)
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Add > BUS

Command Description
It toggles the BUS mode.

Usage & Dialog Box
Choose Add = Bus from pull-down menu of SchEd. The color of port changes
from brown to gray.

t% < The color is changed from brown to gray.

Drag it to the desired position and then drop the end point.

Drag it to the desired position:

&
%3 4 the mouse cursor shape is changed

during BUS drawing.

Note: In the BUS mode, BUS drawing is only possible. To get out of the BUS
mode, double click the left mouse button or choose Add - BUS from pull-
down menu of SchEd.

53



MyLogic Station V5.1

Schematic Editor Manual

Add - Property Template...*
Command Description
It adds the property into symbol object.
Usage & Dialog Box
Edit Dizplay Template E3
' Mode I—L,
Height Ig—
alignmet Iﬁ

List View

Add | Ehangel Qeletel

Cancel |

Add property

Click “Add” button on the Edit Display Template box with the left mouse button.
Then, the Edit Display Template Item dialog box will be shown.
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Edit Dizplay Template tem E3

MHame ||

Walue I

Mode [BOTH =l Edit |vALUE_EN:BLE ]

Font

Height Alighment K

[15 [TOP-LEFT =l R
Cancel |

Specify the name of property at the “Name” text input box by typing. And,
specify the value of name of property at the “Value” text input box by typing.

Change property
Select one of property on the List View of Edit Display Template box, and click
Change button with the left mouse button. Then, the Edit Display Template Item
dialog box will be shown.

Edit Dizplay Template tem E3

MHame IE

Walue |1EIu

Mode [BOTH =l Edit [vALUE_ENABLE =]

Font

Height Alighment 0K

[15 [TOP-LEFT =l I
Cancel |

Change the name or value of property, and click “OK” button with the left mouse
button.
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Shape - Rotate Left

Command Description
It rotates the object to the left by 90 degree.

Shape - Rotate Right

Command Description

It rotates the object to the right by 90 degree.

Shape - Flip Vertical

Command Description
It flips vertically the object.

Shape - Flip Horizontal

Command Description
It flips horizontally the object.
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Layout = Align Left

Command Description
It aligns the selected objects to the leftmost object’s position.

Usage & Dialog Box

Select objects. And, choose Layout = Align Left from pull-down menu of SchEd.
Then, the selected objects are aligned to the leftmost object’s position.

The point where the leftmost object is.

I
s BN,

:jjﬁ]%:
Before doing Layout = Align Left. f
After doing Layout = Align Letft.
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Layout - Align Right

Command Description
It aligns the selected objects to the rightmost object’s position.

Usage & Dialog Box

Select objects. And, choose Layout = Align Right from pull-down menu of SchEd.
Then, the selected objects are aligned to the rightmost object’s position.

After doing Layout - Align Right

B ND
LA, T "m0 ——m

o ND

Before doing Layout = Align Right. ._/ij_\_k!

I

The point where the rightmost object
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Layout = Align Top

Command Description
It aligns the selected objects to the uppermost object’s position.

Usage & Dialog Box

Select objects. And, choose Layout = Align Top from pull-down menu of SchEd.
Then, the selected objects are aligned to the uppermost object’s position.

e, After doing Layout = Align Top.

!
! g e

Before doing Layout = Align Top. T

The point where the uppermost

object is.
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Layout = Align Bottom

Command Description
It aligns the selected objects to the lowermost object’s position.

Usage & Dialog Box

Select objects. And, choose Layout = Align Bottom from pull-down menu of
SchEd. Then, the selected objects are aligned to the lowermost object’s position.

After doing Layout = Align Bottom

A

The point where the lowermost
Before doing Layout = Align Bottom.

object is.
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Layout - Space Across

Command Description
It makes same space between right and left of selected objects.

Usage & Dialog Box

Select objects more than three. And choose Layout = Space Across from pull-
down menu of SchEd. Selected objects are arranged so that spacing between them
becomes the same. The space between objects becomes even in between the
leftmost object and the rightmost object.

After doing Layout 2 Space

-—R{[}p—- -—GI'H-Q- __/_’IJ}JYQ_ Across.

Before doing Layout 2 Space ’—’ﬁ‘g—‘ AR, AR,

Across

The point where the first object is.
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Layout = Space Down

Command Description
It makes same space between top and bottom of selected objects.

Usage & Dialog Box

Select objects more than three. And choose Layout = Space Down from pull-
down menu of SchEd. Selected objects are arranged so that spacing between them
becomes the same.

It is where the first object is.

o P Ther T
I

AR,
!

After doing Layout = Space Down.

Before doing Layout - Space Down.
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Tools = Check Circuit...

Command Description
It brings up the Check Circuit dialog box. It is only activating when the Schematic
View is opened.

Usage & Dialog Box

CEmos 1 Begin | Fiish@) | o« | » | Clse |

Check all ermars |

Irrealid net/bus name

Met dizconnect
Buz has no name
Irvvalid bus width
Irwalid net index List View
Buz zize mizmatch
Shart

Floating input

Ir-port dizconnect
Fort mismatch

Fort duplicate
Met Input{d]

R M B B R S Y B R B R

—WWarnings

v Dut-port disconnect
v Symbol not found
V¥ Net Feedbac(K]

63



MyLogic Station V5.1 Schematic Editor Manual

Start by clicking Checks all errors button with the left mouse button on the Errors
View and if you want to see the warning message, click Warnings button wit the
left mouse button on the Warnings View. And, click Start button with the left
mouse button on the Check Circuits dialog box. Then, the error messages will be
shown at the List View if there is error on your schematic design. If you click the
error message with the left mouse button on the List View, SchEd will display
the location of selected error message into the middle on the Schematic View.

Error Conditions
Invalid net/bus name: it checks the difference between net name and BUS name

Net disconnect: it checks whether there is floating net or not.
Bus has no name: it checks whether there is the name of BUS or not.

Invalid bus width: it checks the difference of bit-number between connected two
BUS signals.

Invalid net index: it checks the index of BUS.

Bus size mismatch: it checks the difference between the bit-number of BUS and
the number of signals that were connected to the BUS.

Short: it checks the short at the schematic.
Floating input: it checks the name of port whether it has its name or not.

In-port disconnect: it checks the name of symbol port whether it has its name or
not.

Port mismatching: it checks the name of port between symbol and schematic.

Port duplicate: it checks the name of port whether they are using same name or
not.
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Net input: it checks whether the name of net is assigned properly or not.

Warning Conditions
It is useful if you want to check the latent error before implementing your
schematic through Hardware System. Sometimes, the schematic will be failed to
implement even though there is no error on the schematic.

Out-port disconnect: it checks whether the out port has its mapping information
for implementing Hardware System or not.

Symbol not found: it checks whether the instance has its symbol or not.

Check Feed Back: it checks whether the net has its feedback information for back-
annotation or not.
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Tools = Simulator

Command Description
It invokes the MySim, logic simulator.

Note: If you want to simulate the circuit level schematic, you should change
the path of simulator into the location of SPICE simulation program. You can
change by clicking Tools->Options...>Path (tab) from pull-down menu of
SchEd.

It shows the current working
schematic view.

Usage & Dialog Box

2 MySim - Simulation Fiesult - [clock /FRAODIV]

| Fie Edt View Signal S Help |
|zsRaR|?
# Simulation Result - [clock/FRADIV] |- [O] =]
@|Q @B|E| =] | E e -] 0] g Fgis
. . . Crus S 0ns 100ns [150ns |[E00ns  |[250ns  |[300ns  |35C
Simulation Time : Ons | ‘ | ‘ | | | | |
s b b e b b o o e o e b
1 1 1
: : : =
—’:IEDmmands: I j
71 [Copyright [C) 19922000 MyCAD, Inc. =]
14l rights reserved.
Ik aking flatten file...
I aking flatten file succesded,
Loading flatten file...
Tatal number of used library cell - 106
=T, simulation £ Fisten J I F
Far Help. press F1 i
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Tools - Import EDIF Netlist...

Command Description

It invokes the schematic generator.

Usage & Dialog Box

i Schematic Generator

EDIF File:

Library:

|| 4 = Browse... |

FEDIFFVHD[

J = Browse... |

Dezign Conexst: & Browse...
w Bun | x Close |

Specify the Ilbrary name
used in the EDIF netlist

Cell

Tokal
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Note: The schematic generator of MyLogic Station does not generate the
schematic data from VHDL netlist for SchEd. And then, it is not available at

circuit level design.

Tools - Export - VHDL

Command Description
It will extract VHDL netlist from schematic data.
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Tools - Export - EDIF 200

Command Description
It invokes the Logic2EDIF Translator.

Usage & Dialog Box

= Logic2EDIF Translator M= Ed

Contewtfile:  [\SDSMCLOCKMclockmde | Open. [ Execue |

Library | lack [ | ot Specify the result name
[

Cell MDD =l with the absolute path.

Besult File : || Browse. . | Options. . |
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Tools - Export - SPICE**

Command Description
It invokes the SPICE Netlist Generator.

Usage & Dialog Box

i SPICE Methst Generator _ [

Contest File ; (BRI el A | = Erowse...l

Library : |circuit j
Cell: [ =l
Result File : I 4 [ Bigwse..

Include Fils : I j = Brnﬂse...l

/ Bun | Wigw | x Qlosel Optian... |
[ |

Specify the result name
with the absolute path.
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Tools - Make Symbol...

Command Description
It makes a symbol with the schematic data.

Usage & Dialog Box

Generate Symbol Ed |

Symbal Title
kA0-10
Forts
Inter-port Gap
[ =] |
Cancel

Symbol Title: it is automatically named by the name of current working
Schematic View.

Inter-port Gap: it means the distance between symbol’s port. The distance units
are the space unit number of SchEd.
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Tools - Make Image File...

Command Description

It copies the whole data of current working Schematic View into clipboard. And
then, the copied data can be saved as an image file such as BMF, GIF, or TIFF.

Usage & Dialog Box

Wako Inogo Fie K
width ; G40
Height ; |43|:I
Iype:  |BMP =l

File Mame : I Browse. .. |
\ Cancel |

Specify the result file name with the absolute path.
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Tools - Customize...

Command Description
It will bring up the customize dialog box.

Usage & Dialog Box

Costomize |

Toolbars Enmmandsl

Cateqones: — Buttons

Standard Y DE- |§ &

Dlemgn [GEGE

et Qe rBRERY DE ?
Wiew

Add

Object

Shape

Lavout |

Window

Toolz -

Select a categony, then click a button to gee its descrphion. Drag the button Toolbars can be
ko any toolbar .

D escription Custom%zed. . To
customize toolbar, just
drag the icon from the
Buttons View at the
right of Commands tab

Ok | Canicel | £pply | Help | and drop it the toolbar

you are customizing. To
remove a command from the toolbar, just drag it from the toolbar and drop it
outside of the toolbar.
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Tools - Options...

Command Description
It brings up the options dialog box.

Usage & Description
Options dialog box is consisted of five tabs namely Color, Data Tip, Print,
Show/Hide, and Path.

Color Tap

Selected object color is displayed.

|

Color | Data Tip| Print | ShowHide | Path

Change Color....

(1] I Cancel | gpply\ | Help

\
\

Symbal Part
Drawing Object
Junction

Met
B

Select one in Object If you want to change the color, click

Type box. here. Then color palette appears.
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The following Color tab determines the default color of each object. Select one of
“Object Type” view whose color to be changed, and then selected object color is
displayed in Color tab. If you want to change the color to another, click Change

Color...button on Color tab. The following dialog box is appeared.

Cuztom colors:

—

Define Cuztorn Colors »» |

ak I Cancel |

Select the color which you want to change. The changed color does not
automatically apply to the object that was drawn before changing the color. It only
applies to the drawing object after changing. The default color of SchEd is

following in the table.

Basic colors field is
provided in SchEd.

Customized colors are

/ displayed in this field.

If you want to add new color to

\

Basic colors, click here. You will
add the custom color to Custom

Colors field

Object Type Color Object Type Color
Symbol Instance | Blue Port Blue
Symbol Port Blue Drawing Object Blue
Junction Sky Blue Net Brown
BUS Gray Selected Region Green
Background White
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Data Tap

The Data Tip page follows.

Select to show datatip

Cologg” Data Tip | Print | ShowrHide | Path |

V¥ Object Hame [ Symbal Port Mame

W Schematic Describer ™ Symbol Port Tvpe

I

Show all datatip lists

0k I Cancel A

Help

Check on “Show Data” check button if you want to show object’s datatip on the

schematic view of SchEd.

Checking on “Object Name”, “Schematic Describer”, “Symbol Name” and
“Symbol Port Direction” determines whether related object's datatips on the

schematic view of SchEd are showed or not.

Object Name

If you check on “Object Name” check box, object name datatip will be displayed

in Schematic View.
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Object name datatip are the object type and the object name.

=4 SchEd - [circuit/inv/schematic]
@Eile Edit Wiew Add Shape Lapout Tools Window Help _Iﬁllﬂ‘
Ded|an|ozszes [EE|e |lea=sa|ls=]=
=458 MyCAD Design Manager : o=
5@ it Bounding box OO o
R v .
B hisrarchy \ datatip o)
e schematic =
-4 Analog . / b
s
g 4 i Object type = Instance fres
Name = "11" &
CAR -
Place the mouse cursor on L
the object: the bounding box ~
and datatip of object is )
displayed. %7 %7 o
GMND GMD it
L ! Tl
For Help, press F1 [=83 =74 ] s
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Schematic Describer

If you check on “Schematic Describer” check box, schematic describer datatip
will be displayed in Schematic View.
Schematic describer datatip shows the object type and the information of object.

=4 SchEd - [circuit/inv/schematic]

B Fle Edit View Add Shape Layout Tools Window Help =15 5||
s e = e e e S
= A=
Ea MuCAD Design M anager DD o
= @ cicu Bounding box datatip o
- BB v o
= hiigranchy
[ schematic 4 -
- Analog [
PMOﬂOhiec’t type = Instance
MR e——y Describer = "Analog/PMOS{s
= E
CARP
Place the mouse cursor on MO 7
the object: the bounding box SRR
and datatip of the object is )
displayed. %7 %7 o
GhD GhD —
4] | S
For Help. presz F1 |« =63 w=77 [ [ 7
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Symbol Name

If you check on “Symbol Name” check box, symbol name datatip will be
displayed at the Schematic view.

=4 SchEd - [circuit/inv/schematic]

B File Edit View Add Shape Layout Tools Window Help ==l ﬂ‘
Ded|ana2zs=es [EE|e |lea=sa|l==]=
=l A=
Ea MyCaD Design Manager C=
‘?"'@%C”“ Bounding box  [*P ©
i EER i [ i
- higtarchy datatip =
- schematic 4 '%—l -
-G Analog
40{ |_;.
PMOS J e
L Object type = Instance}
CAP @
Place the mouse cursor on HMOS a
the object: the bounding box [
and datatip of the object is %7 %7 )
displayed D D 2
=™
ol | A
For Help, press F1 [x =80 =181 ] 4
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Symbol Port Direction

If you check on “Symbol Port Direction” check box, Symbol port direction
datatip will be displayed in Schematic view.

=4 SchEd - [circuit/invfschematic]

|| fie Edt view Add Shape Layout Toos Window Help ;lilzl|
[o=ajegn a2z re=ez [EE|e [lieasa <=l
2l x| =
B3 MyCAD Design Manager =
E@ cincuit Yoo o>
B hienarchy Bounding box datatip
o] schematic 1 -
- Analog ﬁ |
/ ’
PMOS e
1L = CAP B
[Object type = Display -
Place the mouse cursor on iy
the object: the bounding ; |
box and datatip of the %7 )
object is displayed N7 GHD D <
=
| T | LA
Far Help, press F1 [x=-230 y=10 [ 7
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Print Tab

Options

Color | DataTip Print | ShowsHide | Path |

Lirue: width ¥ Show Document Info

T hir
¥ Fix Schematic Printing Factor
Thick

(] I Cancel Sy Help

Line width view on Print tab determines the thickness of the lines to be printed.
Select “Thin”, depicts the thinnest line width to be printed. “Normal” depicts the
standard thickness and “Thick” the thicker lines.

Show Document Info

It determines whether to print the Document Info. or not. If you check off this field,
then the Document Info will not be printed. (Detail things are refer to Document
Info...)

Turn on Fix Schematic Printing Factor
It determines whether Fix the Schematic Printing Factor is applied or not when
print. If you check on this field, then the printing scale is fixed regardless of
schematic design size.
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Show/Hide tab

Only checked selection is displayed at the Preview on Show/Hide tab.

Color | Data Ti|:|| Print  ShowHide IF'ath I

s mes
[~ Port Mames

[ MetMames

[ Instance Mames

[~ Connected points
I~ Document origin

[ Properties

I Instance Port Mames
[ Grid o
I= | Tiewt

Preview

o |

Cancel

Ay

Help
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Symbol names

It determines whether to show symbol name or not at the Schematic View. And
you can also see that on Preview on Show/Hide tab like to the following.

Opons

Color I Data TipI Print  Show/Hide | Fath I

IV Gy =
[~ Port Mames
[ MetMames —

[ Instance Mames

AND2

[T Conmected points

[~ Document origin

[ Properties

[ Instance Port Mames
I Giid [0
=} Tiewt

] 4 I Cancel Sl Help
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Port Names

It determines whether to show the name of port or not at the current working view.
And you can also see that on Preview on Show/Hide tab like to the following.

N > |
Color I Data TipI Print  Show/Hide | Fath I

[ Symbol names
[ MetMames —

[ Instance Mames

00

[" Connected points

[™ Document origin

[ Properties

[ Instance Port Hames
I Grid [0
=] Tewt

] I Cancel Sl Help
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Net Names

It determines whether to show the net names between symbols or not at the

current working view. And you can also see that on Preview on Show/Hide tab
like to the following.

Calor I Data TipI Print  Show/Hide | Fath I

[~ Symbol names
[ Port Mames
i el — I0_o

[ Instance Mames

[T Conmected points

[~ Document origin

[ Properties

[ Instance Port MNames
[ Grid o
= Tiext

ok I Cancel Spply Help
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Instance Names
It determines whether to show instance name or not at the current working view.

And you can also see that on Preview on Show/Hide tab like to the following.

Options

Color I [rata TipI Print Show/Hide | Fath I

[~ Symbol names
[ Port Mames

W Instance Names

[T Connected points

[ Documert origin

[ Properties

[™ Instance Port Mames
I Giid [0
7| Tiest

0k I Cancel sl Help
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Connected points

It determines whether to show the connection between symbol and wire or not at

the current working view. And you can also see that on Preview on Show/Hide
tab like to the following.

Calor I Data TipI Print  Show/Hide | Fath I
[~ Symbol names

[ Port Mames
[T Met Mames ——

[ instance Names

¥ Connected points

[~ Document origin

[ Properties

[ Instance Port MNames
[ Grid o
= Tiext

ok I Cancel Spply Help
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Document Origin
It determines whether to show the document origin or not at the current working
view. And you can also see that on Preview on Show/Hide tab like to the

following.

Oplions

Color I Data Ti|:|| Print Show/Hide |F'ath I

™ Symbol names
[ Port Names ><
[ Met Mames —

™ Instance Names

v Document origin

™ Properties

™ Instance Port Hames
I Gid [0
7| Tew

0k I Cancel i Help
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Properties

It determines whether to show properties of each symbol or not at the current
working view. And you can also see that on Preview on Show/Hide tab like to the

following.

Oplions
Color I Data Ti|:|| Print

™ Symbol names
[ Port Names

[ Met Mames

™ Instance Names
[T Connected points

[ Document origin

™ Instance Port Hames

™ Giid |'|D
7| Tew

Shaw/Hide | Path |

Prop = MyCAD

o]

Cancel i Help
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Instance Port Names
It determines whether to show instance port names or not at the current working

view. And you can also see that on Preview on Show/Hide tab like to the
following.

Options
Color I [rata TipI Print Show/Hide | Fath I

[~ Symbol names
[ Port Mames
[ MetMames

[ Instance Names

[T Connected points

[ Documert origin

¥ Instance Port Mames

[ Grid |'|EI
7| Tiest

0k I Cancel sl Help
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Grid
It determines whether to show the grid or not at the current working view. Type
specified number at the blank box next to Grid check box. The number of the
blank box next to Grid check box is the unit space of SchEd. The default value is
10. If you want to specify the space of grid, type value at the blank box next to
Grid check box.

Calor I Data Ti|:|| Print  Show/Hide |F'ath I

[~ Symbol names
[~ Part Mames
™ Met Mames ———

[~ Instance Mames

[ Connected points

™ Document arigin

™ Properties

™ Instance Port Mames
I G o
= | Tiest

Ok I Cancel Spply Help
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Path tab

Oplions

Calor | Data Tip| Frint | ShowsHide Path |

Simulator IM_I,ISim.e:-:e Browse...

EDIF Translator ILogicEEDIF.exe Browse...

SPICE Translator ILDgicESF’ICE.EHe Browse...

Browze...

ek

Schematic Gen IGen_ exe

] 4 I Cancel | Sppli | Help

It links other tools of MyAnalog Station to SchEd.

“Simulator” text input box is automatically set up for Logic Simulator of MyLogic
Station, so if you want to link SPICE simulator, MySPICE, click on Browe...
button and then locate the directory of MySPICE.

“EDIF Translator” text input box is automatically set up for MyLogic Station. It is
not available on MyAnalog Station.

“Schematic Gen” text input box is automatically set up for schematic generator
of MyLogic Station. It is also not available on MyAnalog Station.

“SPICE Translator” text input box is automatically set up for netlist extractor of
MyAnalog Station.

Note: The default paths of programs are set up for MyLogic Station at Path
tab.
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Window = New Window

Command Description
It will bring up another window for the current activate window.

Window = Close All

Command Description
It will close all current activate windows except for Design Manager.

Window - Cascade

Command Description
It will cascade the windows.
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Window -> Title Horizontally

Command Description
It will arrange the windows in horizontal pattern.

Window -> Title Vertically

Command Description
It will arrange the windows in vertical pattern.
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Translator

Logic2EDIF

Logic2EDIF is a translator from MyLogic Database to EDIF (Electrical Design
Interchange Format) 200 netlist.

. LogicZEDIF Translator M= Ed

Context Eile : || Open... | Erenute I

Librany I j
Huit
LCell: I j $|
FRezult File : I Browsze... | Options... |
=

" o

Context File: Specify the design context file by typing with the absolute path or
by clicking Open... button.

Library: Choose the library. You should select one from library lists that are
contained at the design context file.
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Cell: Choose the cell. You should select a cell from cell lists of the chosen library.

Logic2EDIF translates the data by cell.

Result File: Specify the result file by typing with the absolute path or clicking

Browse... button.

Options...: If you want to specify the option of Logic2EDIF, click it. Then, the

EDIF Configuration dialog box will be shown like to the following.

EDIF Configuration

Configuration |
Target Library ; I W Status ¥ Far gILIN
Arrap Style %3[%d:%d)] yuthor ; Ir-,,jr-,al-,-,E
ember Style : “slzd] Data Origin : |
Program : IM_I,JE.&D Logic ko E
Ground Name - GMD Wersion : IVer$inn 36
Power Mame : YO D Lewvel
tap File : I Browse... | ’7(. One Lol
ak. I Cancel | iy | Help

Target Library: Specify the library name for using at the other program.

Array Style: It is used for BUS translation. If you want to change the BUS name’s

rule from MyLogic to the other program, you should use this option.

Y%s: string type

%d: integer type
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Member Style: It is used for BUS translation. If you want to change the BUS
number’s rule from MyLogic to the other program, you should use this option.

Y%s: string type
%d: integer type

Ground Name: If you want to change the ground name used at MyLogic Station
during EDIF translation into another, specify the ground name at this field.

Power Name: If you want to change the power name used at MyLogic Station
during EDIF translation into another, specify the power name at this field.

Map File: You can specify the map file, which is contained mapping information
between components that used at the different library.

Note: the port number should be same between components that used at the
different library.

The format of map file is the following these:
Edifout*cell_map: “scr_cell=dest_cell” “s_port=d_port”

src_cell: specify the name of source cell

dest_cell: specify the name of destination cell

s_port: specify the source port of source cell

d_port: specify the destination port of destination cell
Example: edifout*cell_map: “IN=INV” “IN1=A" “OUT=B"

Status: It determines whether adds user’s information or not when you translate
from MyLogic Database into EDIF 200 netlist.

Author: Used to include the designer name.
Data Origin: Used to include the vendor name used at the schematic job.

Program: Used to include the name of program used to make the EDIF
netlist.
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Version: Used to include the version number of Logic2EDIF program.

For XILINX: If this box is checked on, then Logic2EDIF would add the extra
information for Xilinx when generate EDIF 200 netlist.

Level: It determines whether only one-level translation or all-level translation. In
general, the database of MyLogic Station has the hierarchy so that you should
specify the level for Logic2EDIF to translate whether only current level or all.
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SPICE Netlist Generator

SPICE Netlist Generator is a netlist extractor from MyLogic Database to SPICE
format netlist such as Standard SPICE format or HSPICE format. The extracted
netlist from SPICE Netlist Generator can be used for both SPICE simulation and
LVS (Layout Versus Schematic) with MyChip Station.

i SPICE Hetlist Generator _ [ x|
LContest File : I j = ﬁrnw&e...l
Library : I j
Cell: | =l
Eiesult File : | = Browse... |
Incure File | = = Brnﬂms...l

V Bun | e | x ansel Option... |
=

4 o

Context File: Specify the design context file by typing with the absolute path or
by clicking Browse... button.
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Library: Choose the library. You should select one from library lists that are
contained at the design context file.

Cell: Choose the cell. You should select a cell from cell lists of the chosen library.
SPICE Netlist Generator extracts the data by cell.

Result File: Specify the result file by typing with the absolute path or clicking
Browse... button.

Include File: Specify the model parameter file for SPICE simulation by typing
with the absolute path or clicking Browse... button. It is the optional.

Option...: If you want to specify the option of SPICE Netlist Generator, click it.
Then, the Option dialog box will be shown like to the following.

T |

Metlist Format Structure ——
%' Spice 3 =" Flat
™ HSpice i~ Hierarchical

) ESpice
Cancel |

Netlist Format: It determines the netlist format generated from SPICE Netlist
Generator whether standard SPICE (Spice3) or HSPICE (HSpice).
Structure: It determines the structure format whether flatten (Flat) or
Hierarchy (Hierarchical). If you select “Spice3” at Netlist Format view, then,
you could not select “Hierarchycal” at Structure view because standard
spice does not support hierarchy netlist format.
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Schematic Generator

Schematic Generator is used for generating schematic data with EDIF netlist or

VHDL netlist.

Note: Schematic Generator does not support to generate from VHDL netlist

to MyLogic database.

E_ Schematic Generator

EDIF File: |
& EDIF € VHDL

j = Browse. . |

Librany: I

j = Ergwse...l

Design Conexst: I

wﬂunl

n Browse. .. |
x Cloze |

[ |

Cell

Tokal
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EDIF File: Specify the EDIF netlist by typing with the absolute path or clicking
Browse... button.

Library: Specify the library name used at EDIF netlist by typing with the absolute
path or clicking Browse... button.

Design Context: Specify the design context file for SchEd by typing with the
absolute path or clicking Browse... button.
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Appendix I. State Table

In this section, the procedure of the State Table’s usage is described.

Choose File>New from pull-down menu of SchEd. Then, the Create View
Dialog dialog box will be shown.

Create Yiew Dialog E |

Library Mame: Ital:ule j
=43 table
- Type cell name
Cell Mame: state_table = Ok, I
Wiew M ame; Cancel |

Select the type of view:
statetable

Type cell name at the “Cell Name “text input box. And choose the type of view as
statetable. Then, the Create Table dialog box will be shown.
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Create Table [ x|

Ports List ~ Mew Part

Fort Mame

Paort Type
" Input

) Output
1 Sddtess
) Diata

1 Flesult

Add Port | Hemove |

< Bach I Finish I Cancel | Help |

Type port name at “Port Name” text input box on New Port view. And choose
the port type either input or output by checking on at Port Type selection view.

Click Add port button with the left mouse button on the Create Table dialog box.
Then, the port will be appeared at the Port List view on the Create Table dialog
box. (The following is one of example. Where “s” is input port and “qa” and “qb”
is output port.)
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Create Table [ x|
Ports List — Mew Part
[ = Part Marne
L ga Iqb
<> gh
Paort Type
" Input
= Output
) fddiess
) Diata
= Hesult
Eemove |
< Back Finizh Cancel | Help |

Click Finish button with the left mouse button after finishing to create ports.

Then, the Statetable view will be shown on SchEd.

[3 table/state_table/statetable Mi=] E3

Data State Mext State Rezult

qaqgb
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And, choose View = Properties... from pull-down menu of SchEd. Then, the
State Table dialog box will be shown. You can specify the property of state table
using by the State Table dialog dox.

State Table

— Ports

Input Parts Show the input ports

i

A

Output Ports

Iqa gh

/ — States

Current States

Show the output ports |

Mewxt States

M um of Fows

1] I
ID Cancel |

Current States: specify the variable names of current state. During that, you
should consider the total number of variable names before specifying the current
state. For example, type B A at the “Current States” text input box.

Note: Between variable names should be the space. If not, SchEd will
recognize them into a single variable.
Next States: specify the names of next state. The total number of next states
should be same of that defined at the Current States text input box. For example,
type B” A” at the “Next States” text input box.

106



MyLogic Station V5.1 Schematic Editor Manual

Note: Between variable names should be the space. If not, SchEd will
recognize them into a single variable.

Num of Rows: type the total number of the state. And the number of port and of
state determines it. For example, the number of state and of port is each 2(two)
and 3(three), then the value of “Num of Rows” text input box should be 8(eight)
because the total number of row is calculated by the formula, (the number of
state)**(the number of port).

If you follow the above, then the Statetable View will be shown the following;:

Cata State Mext State Result You can modify these
by double clicking each
Mame |z B A B'a gaqgb field.
1 0 0o 0o 0o N
2 0 0o 0o 0o
3 0 0o 0o 0o
4 0 0o 0o 0o
5 0 0o 0o 0o
E 0 0o 0o 0o
7 0 0o 0o 0o
8 0 0o 0o 0o J
)

Then, you modify the above table by the following.
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Note: To modify a field at the state table, double click it. Then, type values.

Current State Input Next State Result(Output)
B A s B’ A’ qa qb
00 0 00 00
00 1 10 01
10 0 10 01
10 1 01 10
01 0 01 10
01 1 11 11
11 0 11 11
11 1 00 00

After finishing to type values for each field at the state table, you should make it
into a symbol to use at the other schematic by choosing Tools = Make Symbol...

from pull-down menu of SchEd.
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[&3 tablefstate_table/symbol =] I

state table

ga —®
L qb_. J

-

Kl 1 2y

At the other schematic, you should set up the Simulation Model to “state table”
at the property of the instance for simulation on MySim.

Instance Ed |

Inztance Property | F'n:.pertiesl

Imstance Mame - |ID Made : I‘MLLIE oMLY vI

— Describer
Library : Ital:ule Browser ... |
Cell: |state_tal:ule

Simulation kodel:

— Comment
. . . . . Calor... |
Instance iz a schematic object representing symbal.

“'ou can chooze any symbal from the library or make
waur awn gymbol with zumbal editar,
Beset |
k. I Cancel [ | Help |
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Appendix Il: Truth Table

In this section, the procedure of the Truth Table’s usage is described.

Choose File 2New from pull-down menu of SchEd. Then, the Create View
Dialog dialog box will be shown.

Create Yiew Dialog E |

Library Mame: I table j

Ela table L]
- state_table

Type cell name

Select the type of view:

truthtable
Cell Name: Itruth_tal:ule | K I
Wiew Mame: | Cancel |

Type cell name at the “Cell Name” text input box. And, choose the type of view
as truthtable. Then, the Create Table dialog box will be shown.
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Create Table

Parts List — Mew Paort

Fort Harne

— Port Tepe
" Input

" Output
£ Lddress
) [ata

£ Fesult

add Port | EEmove I

< Biael I Finizh I Cancel | Help |

Type port name at “Port Name” text input box on New Port view. And choose
the port type either input or output by checking on at Port Type selection view.

Click Add Port button with the left mouse button on the Create Table dialog box.
Then, the port will be appeared at the Port List view. (The following is one of

“o_n

example. Where “in1” and “in2” is input port and “q” is output port.)
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Create Table
Parts List — Mew Paort
= in Part Hame
[Co=inz Iq
g
— Port Tepe
" Input
' Output
) Eddiess
) Dat
£ Hesult
EEmove |
< Biael Finizh Cancel | Help |

Click Finish button with the left mouse button after finishing to create ports.

Then, the Truthtable view will be shown on SchEd.

EH table/truth_table/truthtable _ (O] x|
| [rata Rezult |
Mame |inl inZ q
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And, choose View ->Properties... from pull-down menu of SchEd. Then, the
Truth Table dialog box will be shown. You can specify the property of truth table
using by the Truth Table dialog box.

Show the ports that
Truth Tabl .
o ane | defined at the Create
~ Parts N Table dialog box.
|hput Ports
Iirﬂ inZ2
Cutput Parts >
|l:|
J

MHum of Bows

II:I Cancel |

Specify number on “Num of Rows” text input box. The total number of input
ports determines the value of row. In this example, the total number of input
ports is “2(two)” so that the number of row becomes “4(four)” by the formula,
2***(the total number of input ports).

If you type “4(four)” at the “Num of Rows” text input box, then, the following
will be shown.
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You can modify these
by double clicking each

E:A table/truth_table/truthtable M=l E3 field.
Data Fesult
Hame |inl ing q
1 1] i
2 i i
3 1] 1]
4 1] a pl

Then, you modify the above table by the following.

Data Result
Name inl in2 q
1 00 0
2 01 0
3 10 0
4 11 1

Note: If you want to modify the name field, you should space between names.
If not, SchEd will recognize it as a name.

After finishing to type values for each field at the truth table, you should make it
into a symbol to use at the other schematic by choosing Tools = Make Symbol...
from pull-down menu of SchEd.
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fa3 table/truth_table/symbol [_ (O] x|

truth_table
B in
B inZ " —

4] | 2V

At the other schematic, you should set up the Simulation Model to “truth table”
at the property of the instance for simulation on MySim.

Instance

Instanice Property I Froperties |

Instance Mame : IE Mode I\-"p'-‘-.LLIE OMLY "l

— Drescriber
Library : I[able Browser ... |
Cell: Itrulh_lable
Sirnulation Model: Itruth table j

— Comment
. . : . Calor... |
Ihstance is a schematic object reprezenting symbol.

Y'ou can choose any symbaol from the library or make
your awn spmbol with symbol editar,

Reset |

(0] I Cancel AEpli Help |
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Appendix Ill: Rom Table

In this section, the procedure of the Rom Table’s usage is described.

Choose File 2New from pull-down menu of SchEd. Then, the Create View
Dialog dialog box will be shown.

Create Yiew Dialog E |

Library Mame: Ital:ule j
=43 table

Cell Mame: IrDI’ﬂ_tablE OF. I

Wiew M ame; Iru:un" j Cancel

Type cell name

/

Select the type of view:
rom

Type cell name at the “Cell Name” text input box. And, choose the type of view
as rom. Then, the Create Table dialog box will be shown.
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Create Tahle

Parts List — Mew Paort

Fort Harne

— Port Tepe
) ot

) [utput
 Addiess
) ata

" Result

Add Port | Hemave |

<Back |8 Rish T

Cancel | Help |

Type port name at “Port Name” text input box on New Port view. And choose
the port type either input or output by checking on at Port Type selection view.

Click Add Port button with the left mouse button on the Create Table dialog box.
Then, the port will be appeared at the Port List view. (The following is one of
example. Where “ADDRJ[1:0]” is address port and “SEQ[1:0]” and
“VALUE[3:0]” is result port.)
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Create Table
Parts List — Mew Paort
= ADDR[1:0] Port Marme
L SEQ[1] IVALUE[S:D]
o ALE[3:0]
— Port Type
) ot
) [utput
 pddress
) Diata
& Fesult
Add Paort | Hemaye |
< Back P Finigh Cancel | Help |

Click Finish button with the left mouse button after finishing to create ports.

Then, the ROM view will be shown on SchEd.
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# rable/rom_table/rom _ O]

In-Clock [Optional]
when I
when I
tem-Enable [Optional)

I whenl_ Empertyl

Address Reszult

Out-Clock [Qphional]

MName | ADDR[1:0] SEQ[:01WALUE[Z:0]

And, choose View ->Properties... from pull-down menu of SchEd. Then, the
ROM Table dialog box will be shown. You can specify the property of truth table
using by the ROM Table dialog box.

ROM Table =]

— Partz
Addrezs Ports

Rezult Portz
ISEDH O] WALUE[3:0]

MHum of Bows

II:I Cancel |
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Type “4” at “Num of Rows” text input box. It is due to the bit-number of address
port is 2. [2**(bit-number of address port) = 4]. Then, the ROM view is changed

into the following diagram.

i table/rom_tablefrom

In-Clock [Opticnal]

Out-Clack [Optional]

kem-Enable [Optional)

M=
when[
when [
when [ ﬂl

Address

Fiesult

Hame [aDDR[1:0]

SEQ:0]VALUE[Z:0]

1 oo 00 0000
2 0o 00 0000
3 0o 00 0000
4 0o 00 0000

You can modify these
by double clicking each
field.

/

>

In-Clock (Optional): It controls the address port of ROM whether it works or not.
You can specify the port name of in-clock by typing the name if in-clock port at
“In-Clock (Optional)” text input box and the condition of in-clock port by typing
the value at “when” text input box next to “In-Clock (Optional)” text input box. If
you do not set up the port name of in-clock, then, the address port of ROM will

always work.

Note: The condition of in-clock port should be “0” or “1”. Where “0” means the
falling edge of in-clock signal, “1” means the rising edge of in-clock signal. If
you set “when=1", then the register of address port start to work when the

120




MyLogic Station V5.1 Schematic Editor Manual

value of in-clock port is falling edge. In the other case, the previous value of
register of address will be kept.

Out-Clock (Optional): It controls the result port of ROM whether it works or not.
You specify the port name of out-clock at “Out-Clock (Optional)” text input box
and the value of “when” next to “Out-Clock (Optional)” text input box. If you do
not set up the port name of out-clock, then, the result port of ROM will always
work.

Note: The condition of out-clock port should be “0” or “1”. Where “0" means
the falling edge of out-clock signal, “1” means the rising edge of out-clock
signal. If you set “when=1", then the register of address port start to work
when the value of out-clock port is falling edge. In the other case, the
previous value of register of result will be kept.

Mem-Enable(Optional): It controls to work ROM or not. If you set up the
memory clock with condition, ROM will work when it meets the condition. And
the other case, ROM will be high impedance. If you do not set up the memory
clock, then ROM will always work.

Note: The condition of memory clock port should be “0” or “1”. Where “0”
means the falling edge of memory clock signal, “1” means the rising edge of
memory clock signal.

The following diagram might help you to know the option setting of ROM.
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Address

clk in

— iy| ADDRESS

ROM
clk out ; Y :
— +*| RESULT
Then, you modify the above table by the following.
Data Result
Name ADDRJ1:0] SEQI1:0] VALUE]J3:0]

1 00 00 0000
2 01 01 0011
3 10 10 1100
4 11 111111
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Note: If you want to modify the name field, you should space between names.
If not, SchEd will recognize it as a name.

After finishing to type values for each field at the ROM table, you should make it
into a symbol to use at the other schematic by choosing Tools = Make Symbol...
from pull-down menu of SchEd.

full tablefrom_table/symbol [ _ (3]

-

rom_table

I —a
[ o ADDR[TDJ SEQT0] J
ALUE[3:0)—™

-

|« _ 1 2y

At the other schematic, you should set up the Simulation Model to “truth table”
at the property of the instance for simulation on MySim.
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Instance

Instance Property | Pmpe[liesl

Instance Name : IE HMode I\-".-’-‘n.LUE OMLY "l

— Descrber
Libram : I[ab|e Browser ... |
Cell:

Ilom_table

Simulation tadel: I schematic

[
— Comment

. . ) Color. ..
Instance is a schematic: object representing spmbal. . ;l

'ou can chooze any gymbol from the ibrary or make
Reset |

your own symbol with symbol editor,
ak. I Cancel L | Help I
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Appendix IV: Ram Table

In this section, the procedure of the Ram Table’s usage is described.

Choose File 2New from pull-down menu of SchEd. Then, the Create View
Dialog dialog box will be shown.

Create Yiew Dialog E |

Library Mame: Ital:ule j Type cell name
E__a table /

Cell Mame: |ram_ta|:u|e x | Ok I

"Wiew Marne: Iran“ _;J Cers | Select the type of view:
ram

Type cell name at the “Cell Name” text input box. And, choose the type of view
as ram. Then, the following dialog box will be shown.
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i table/ram_table/ram M= E3

Data Type values
Addresz

Yrike-Enable

I whenl

In-Clack [Dptional] >

I whenl

Out-Clock [ ptional]

I whenl

R ezult

| J

RAM table has the write enable port. It controls the status of ROM whether write
mode or read mode. And, RAM does not need values of address port. The usage
of in-clock port and out-clock port is similar with RAM table.
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Appendix V: Logic Equation

In this section, the procedure of the Logic Equation’s usage is described.

Choose File>New from pull-down menu of SchEd. Then, the Create View
Dialog dialog box will be shown.

Create Yiew Dialog E |

Library Mame: Ital:ule j Type cell name
== table /

Cell Marne: II:::giu:_equatiu:un | (] I

| Select the type of view:

Yiew M arne: ILDgicEquatiDn _;J Cancel
LogicEquation

Type cell name at the “Cell Name” text input box. And, choose the type of view
as LogicEquation. Then, the following dialog box will be shown.
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B tableflogic_equation/LogicE quation M= E3
I a I

-

4] 2

The input method of logic equation is the text at LogicEquation view. The
following table shows the list of operator that is available at logic equation design.

Operator Meaning
+ OR
* AND
! NOT

SchEd will recognize the line which is starting with “//” into comment.
The following shows the syntax of logic equation.

LogicEquation :=header cell_name interface contents

128



MyLogic Station V5.1

Schematic Editor Manual

Header
Cell_name
Interface

Inputs

Outputs
Variables
Contents
Assignment_expr

Expression

Or_expr

And_expr

Unar_expr

Primary_expr

:=| LogicEuation-V100 |

:=CELLNAME string

:=input outputs variables

:=INPUT (signal_name)*SEMI_COLON
:=OUTPUT(signal_name)*SEMI_COLON
:=VARIABLE (local_signal_name)*SEMI-COLON
:=CONTENTS end_of_line (assignment_expr)*END
:=signal ASSIGN_OP expression SEMI-COLON
:=and_expr

| or_expr expression

:=primary_expr OR_OP primary_expr
=unary_expr

| and_expr AND_OP unary_expr

:=NOT_OP primary_expr

| primary_expr

:=signal

|10
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| (expression)

Signal :=[signal_name | local_signal_name]
Comment :=/ /string end_of_line
OR_OP =+
AND_OP =
NOT_OP =l
SEMI_COLON =,

Note:

-. The width of operand signal between left-hand side and right-hand side
should be same.

-. You can only assign the value of result signal.

-. You do not need to type the header of Logic Equation because SchEd
automatically save it when it is closed.
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The following is an example of Logic Equation:

/I This is comment line
CELLNAME LESample;

INPUTS data[3:0];
OUTPUTS out1[3:0];
Variables tmp1l, tmp2;
CONTENTS

tmpl = data[3] + data[2];
tmp2 = data[1] * data[0];
outl[3] = tmpl;

outl[2] = tmp2;

outl[l] = 1,

out1[0] = 0;

END
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Appendix VI: State Diagram

Some of full-down menu of SchEd will be changed when you design the

schematic with state diagram at State Diagram view.

The following diagram is one of example of state diagram.

=4 Table/SD_MOD2/statediagram

The output
of status

Variables  [——_|

] g =="0"
Ca Qb ==
{h

-

AN

The start status

The transition

Conditions
~

Note: To simulate the state diagram, you should extract to VHDL netlist by

choosing Tools - Extract - VHDL from pull-down menu of SchEd.

132



MyLogic Station V5.1 Schematic Editor Manual

The following is description concerning to the new menu that are only appeared
at State Diagram view.

Add->State

Command Description
It adds the state object into State Diagram view.

Usage & Dialog Box

=4 table/state_diagram/statediagram

Handle:
the status object
has four handles

-

KN | 2

Choose a handle and drag the mouse to a desired location and release it. Then,
you can make a status object’s shape. Double click the status object. Then, State
dialog box will be shown.
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State

State |

Mame ISU . Calor... |

I™ St stare [Synchionous 7
[ Eil

Outputs
tate="00"

ak. I Cancel | L | Help I

Name: It shows the name of selected status object. You can change the name by
typing.

Color: It shows the color of selected status object. The default color of it is black.
You can change the color by clicking Color.. button. Then, Color dialog box will
be shown. Choosing a color at Color dialog box.

Start state: If you check on it, then selected status will be the start of state diagram
and change the boundary into double-line.

Synchronous: You can set the status into synchronous.
Asynchronous: You can set the status into asynchronous.

Fill: If you check on it. Then, selected status will be filled. When the filled status is
current working, the output will be the filled status.

Outputs: Type the output value of state.
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Add = Transition

Command Description
It adds the transition object into State Diagram view.

Usage & Dialog Box

=4 table/state_diagram/statediagram

|__— Handle:
;3 the transition object
has five handles

1

=] =]
—
It indicates the direction
- | oftransition.
< L ﬁ

5

Choose a handle and drag the mouse to a desired location and release it. Double
click the transition object, Transition dialog box will be shown.
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Transition
Tranzition |

Conditions :

I [ Elze

Outputs ©

(0] I Cancel | AEpli | Help

You can the condition of transition at Transition dialog box.
Conditions: Set the condition of transition.

Else: If you check on this box, you could set the state for else condition.
Outputs: Type the output value of state.

Note: SchEd will display the transition condition with the underline on State
Diagram view.
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Add = Variables...

Command Description
It adds the variables.

Choose variable type:
Input, Output, Variable,

Usage & Dialog Box Clock, and Reset.

Yanables

EU |.|:||:||::l::_.|
RESET [Resetf)

Type variable name

Display the variable
with its type.

] I Cancel |
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Tools - Verify

Command Description
It checks the state diagram whether it contains error or not.
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